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开始使用 TI-Nspire™ CX II手持设备

TI-Nspire™ CX II 和 TI-Nspire™ CX II CAS 手持设备是 TI-Nspire™ 系列产品中最新的
手持设备。该手持设备采用背光彩色显示屏，外形轻薄，提供触摸板导航、动
态绘图以及可交互计算机的功能。

手持设备和 TI-Nspire™ 软件共享相同的功能，您可以将课堂作业从手持设备
传送到计算机或在您需要移动时将文档传送到手持设备。利用软件的全彩色
显示屏和简单易用的导航功能在学校布置作业，然后在家完成。使用该软件
可以在有最新的软件和手持设备操作系统更新时进行下载，确保您用到最新
的增强功能。

本指南涵盖以下 TI-Nspire™ CX II 手持设备 :

• TI-Nspire™ CX II / TI-Nspire™ CX II CAS

• TI-Nspire™ CX II-T / TI-Nspire™ CX II-T CAS

• TI-Nspire™ CX II-C CAS

• TI-Nspire™ CX II EZ-Spot

尽管它们在许多方面操作相同，但仍有一些差异。如果 Numeric、Exact
Arithmetic 或 CAS 手持设备之间存在差别，将会指出并介绍适当的操作。

关于数学模式

TI-Nspire CX II 手持设备以三种模式之一执行计算 :Numeric、Exact Arithmetic 或
计算机代数系统 (CAS)。

Numeric 模式仅支持浮点数、整数和竖式分数的结果。

Exact Arithmetic 模式支持浮点数、整数、竖式分数、p、e、根号 ‡ 和其他常数
( 如 ln(5) 和 sin(2)) 的结果。

CAS模式支持与 Exact Arithmetic 相同的结果，还支持符号操作( 如 x+x) 和 CAS
函数，如符号因式分解、求方程、限值和不定积分。

可用的数学模式取决于您拥有的 TI-Nspire CX II 手持设备型号 :

手持设备型号 数字 精确算法 CAS

TI-Nspire CX II Ÿ

TI-Nspire CX II CAS Ÿ 1 Ÿ Ÿ

TI-Nspire CX II-T Ÿ 2 Ÿ

TI-Nspire CX II-T CAS Ÿ 1 Ÿ Ÿ

TI-Nspire CX II-C CAS Ÿ 1 Ÿ Ÿ
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2 开始使用 TI-Nspire™ CX II手持设备

1 CAS 模式关闭

2 Exact Arithmetic 模式关闭

TI-Nspire™ CX II-C 中文彩屏图形计算器按键

TI-Nspire™触摸板 的使用方法跟笔记本电脑触摸板一样。您还可以按触摸板
的边缘上下左右移动。

d删除屏幕上的菜单或对话框。也

可以停止正在进行的计算。

» 打开便签本进行快速计算和绘

图。

e移至下一个输入字段。

g使下一个键入的字符为大写。

/使用每个键上显示的函数或字

符。也可与其他键组合用作快捷方式

c打开图形计算器。如果图形计

算器已开机，此键可显示主屏幕。

~打开 “文档 ”菜单。

b显示应用程序或关联菜单。

.删除前一个字符。

h显示已保存的变量。

·计算表达式、执行指令或选择菜

单项。

注意：键盘上的 ¢符号表示可以访问多个选项。要访问一个选项，请反复按

º或使用触摸板上的箭头键。按·或单击选择该选项。

准备 TI-Nspire™ CX II-C 手持设备 以供使用

TI-Nspire™ CX II-C 和 TI-Nspire™ CX II-C CAS 手持设备配有可充电的锂电池。各手
持设备还附带以下配件 :

• 标准迷你 A 到迷你 B USB 线缆的连接，用于传送文件到其他手持设备

• 标准 A 到迷你 B USB 线缆以供与计算机之间传送文件和为电池充电

为手持设备充电

▶ 使用以下方式之一，将电池充电至少 4 小时以确保最佳性能。

- 使用标准 A 到迷你 B USB 线缆将手持设备连接至计算机上。要下载包
含驱动程序的软件，请转至 education.ti.com/software。

- 使用 TI 墙壁适配器( 单独出售) 连接到墙壁电源插座。

- 若在教室环境中，请将一台或多台手持设备放在 TI-Nspire™ CX Docking
Station 中。



注意 : TI-Nspire™ CX II-C 手持设备可具有“深度睡眠”功能，以最大程度地延长电
池寿命。具有此功能的手持设备有一个蓝色重设按钮。如要将手持设备从

“深度睡眠”模式中唤醒，请按住c至少 4 秒钟或使用 USB( 计算机或墙壁

适配器) 或扩展坞电源。唤醒此手持设备后，可随时通过按c将其开启。
在延长储存时间的情况下，为了最大程度地延长电池寿命，请启用“深度睡
眠”模式。如要让手持设备进入“深度睡眠”模式，请按住手持设备背面的重设
按钮至少 4 秒钟。

注意 : 有关充电电池的更多信息，请参阅配置 TI-Nspire™手持设备。

首次打开 TI-Nspire™ CX II 图形计算器

电池充电后，按c打开图形计算器。加载操作系统时会显示进度条。接
下来，在出现提示时选择语言首选项和字体大小。

注意：要关闭图形计算器，请按/c。设置和内存内容将会保留。

使用自动断电功能

为了延长电池寿命，自动断电 (APD™) 功能会在不活动状态持续三分钟后关闭

图形计算器。出现此情况时，按c可打开图形计算器并返回到最近访问

的一个文档或菜单。要更改默认设置，请按c53访问图形计算器设
置屏幕并在该屏幕中更改电源待机设置。

注意：有关设置图形计算器的更多信息，请参阅配置 图形计算器。

选择语言

载入操作系统后，选择首选语言。

1. 按 ¢打开下拉菜单。

2. 按 6 滚动显示语言，然后按x或·选择一种语言。

3. 按e高亮显示确定按钮，然后按x或·保存语言选择。

选择字体大小

接下来，选择显示的字体大小。

开始使用 TI-Nspire™ CX II手持设备 3



4 开始使用 TI-Nspire™ CX II手持设备

1. 按 ¢打开下拉菜单。

2. 按 6 高亮显示字体大小，然后按x或·进行选择。

3. 按e高亮显示确定按钮，然后按x或·打开欢迎！屏幕。

4. 要继续，按x或·选择确定并打开主屏幕。



调整背光亮度

TI-Nspire™ CX II-C 中文彩屏图形计算器的屏幕带有背光，因而可以在各种光线
条件下轻松使用。默认情况下，亮度设置为中等。要调节背光亮度：

• 较暗：按住/并轻触-。

• 较亮：按/并轻触+。

使用 TI-Nspire™ 触摸板

使用触摸板可以导航或完成使用箭头键和 Enter 键可以完成的任何任务。使
用触摸板通过以下两种方式导航：

• 象使用计算机触摸板一样使用，即通过移动指尖在触摸板中间区域滑动
以激活和移动鼠标指针。单击或轻触触摸板中间，选择一个菜单选项或完
成一个操作。

• 按触摸板外边缘上的箭头键上下左右推动鼠标指针，然后单击ex或

按·完成操作。

如果按住一个箭头键，鼠标指针将朝该方向持续移动。

注意：如果鼠标指针在命令或文件上显示，单击或轻触触摸板中间的x可选
中该命令或文件。如果该命令或文件已高亮显示，将指针移到该项目上或按

·即可选中。

在应用程序中工作时，使用触摸板可访问关于问题的更多信息。例如，悬停
在图形与几何对象之上会显示关于该对象中使用的变量和可用工具的信息。

有些用户喜欢自定义触摸板设置；从而加快和减慢指针移动速度，或启用轻
触代替单击。要更改触摸板的默认设置，请参阅配置中文彩屏图形计算器。
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6 开始使用 TI-Nspire™ CX II手持设备

了解便签本

使用便签本可进行快速计算和绘图而不会影响当前的 TI-Nspire™ 文档。例如，
当您需要快速测试计算然后将其添加到文档时，您可以打开便签本应用程序
并进行计算。然后，您可以放弃计算或将其添加到文档中。有关便签本的更
多信息，请参阅使用便签本。

使用 Home(主页 )屏幕

手持设备上执行的所有活动都从“主页 ”屏幕开始 :

• 打开便签本进行快速计算和绘图

• 创建新文档

• 打开和管理现有文档

• 定义设置和查看状态

• 查看操作手持设备的提示

• 访问最近的文档

• 返回到当前文档

注 :按c在主页屏幕和当前文档间切换。

Home( 主页) 屏幕选项

菜单选项 用途

便签本

使用便签本菜单选项可打开计算器或图形应用程序，且不影响您的文档。

在 Scratchpad( 便签本 ) 中，按» 可在以下 Scratchpad( 便签本 ) 应用程序之

间切换 :计算和图形。

计算 打开便签本，并激活 “计算器 ”应用程序。从 “主页 ”屏
幕中，键入 A。

图形 打开便签本，并激活 “图形 ”应用程序。从 “主页 ”屏幕

中，键入 B。

文档

要选择处理文档的选项，请按关联的数字或使用触摸板选择一个图标，然

后按x或·。

新建 打开一个新的 TI-Nspire™ 文档并列出可用的应用程
序。

浏览 打开文件浏览器，从此处打开现有的 TI-Nspire™ 文档
或将文件发送给其他人。



菜单选项 用途

最近 列出最近保存的五个文档。

电流 转至当前打开的文档。

设置 检查手持设备的状态和更改设置。

应用程序图标

要向当前文档添加新的页面，请选择一个应用程序图标。如果没有已打开
的文档，则将打开一个新文档，其中的新页面包含选定的应用程序。

计算器 在文档中添加用于输入和计算数学表达式的页面。

图形 添加用于绘制和探究函数的页面。

几何 添加用于创建和探究几何形状的页面。

列表与电子表格 添加用于处理表格数据的页面。

数据与统计 添加页面并提供用于在不同类型的图表中实现数据
集可视化的工具，以及用于处理数据集以了解各数据
集之间关系的工具。

记事本 提供文本编辑功能，用于将文本添加到 TI-Nspire™ 文
档作为备注或与其他用户共享。

Vernier DataQuest™ 添加页面，用于收集和分析来自传感器或探头的数
据。

要了解有关应用程序和文档的更多信息，请参阅《在 TI-Nspire™手持设备上处
理文档》。

TI-Nspire™ CX II-C 手持设备屏幕

当您在手持设备上的文档中工作时，屏幕顶部的图标提供关于手持设备操作
状态的信息，并提供更改设置的快捷方式。这些图标的说明如下。
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8 开始使用 TI-Nspire™ CX II手持设备

图标 功能

¡ ¢ 页面滚动箭头 - 使用触摸板来单击这些箭头以在文档中滚动页面。

页面选项卡 - 为活动页面标注问题编号和页面编号。例如，标签为
1.2 表示问题号为 1，页码为 2。如果问题已命名，将指针悬停在选
项卡上可查看页面名称。

*Doc 文档名称 - 显示当前文档名称。文档名称旁的星号表示该文档自上
次保存后进行过更改。单击此名称可以打开文档菜单。

测验模式 - 指示手持设备处于测验模式。

登录状态 - 显示手持设备正在搜索接入点 ( 闪烁 ) 、已找到接入点
( 稳定亮起 ) 、不通信、已连接并可登录 ( 闪烁箭头 ) 或是已登录并已
充电 ( 稳定亮起的箭头 ) 。单击此处可查看设置与状态。

CAPS 显示g、/和Ê键的状态。

弧
度

角度模式 - 显示在用角度模式的简明信息 ( 角度、弧度或百分度 ) 。
将指针悬停在指示器上可查看全名。

注 :单击指示符在 RAD 和 DEG 模式之间切换。

设置与状态 - 显示电池当前充电电量的指示条。将指针悬停在指示
条上可以显示以百分比表示的进度。单击图标以打开设置与状态
菜单。

关闭文档 - 单击图标以关闭当前文档。如果信息没有保存，请在提
示时保存或放弃。

使用提示

对图形计算器上所有的软件而言，提示就是对应的快速帮助。有几种简单的
方式可以访问提示：



• 按/µ。

• 某些对话框包含一个问号图标。单击此图标可打开该任务的提示。

要滚动浏览提示，请使用触摸板或方向键：

• 要向下翻页，请按/3。

• 要向上翻页，请按/9。

• 要转至提示文件的末尾，请按/1。

• 要返回该文件的开头，请按/7。

使用键盘快捷方式

使用下列键盘快捷方式执行常规功能。您还可以通过从菜单中选择选项来执
行所有功能。

获得帮助

打开提示 /µ

编辑文本

剪切 /X

复制 /C

粘贴 /V

还原 /Z

/d

恢复 /Y

gd

切换近似结果和精确结果

Python 编辑器和 Shell: 在当前行之后添加新行。

/·

英文 :更改键以包含相应的音调

中文 :插入字符
;

在文档中插入字符和符号

显示字符 /符号面板 /k

开始使用 TI-Nspire™ CX II手持设备 9



10 开始使用 TI-Nspire™ CX II手持设备

下划线 /_

显示数学模板面板 t

反斜杠 (\) gp

手动数据捕获点 /^

清除 /.

大写锁定 /g

存储 /h

方括号 /(

花括号 /)

显示三角符号面板 µ

等号 =

显示圆周率符号面板
( p、à、q 等 )

¹

显示等式 /不等式面板
( >、<、≠、≤、≥ 和 | )

/=

显示标记和字母符号面板
(? ! $ ¡ ' % " : ; _ \)

º

平方根 /q

log /s

ln /u

ans /v

管理文档

打开文档菜单 ~



打开文档 /O

关闭文档 /W

创建新文档 /N

插入新页面 /I

选择应用程序 /K

保存当前文档 /S

/»

导航

页首

Python 编辑器和 Shell: 将光标移至程序中第一
行的开头。

/7

页尾

Python 编辑器和 Shell: 将光标移至程序中最后
一行的末尾。

/1

上一页 /9

下一页 /3

向上一级 /£

向下一级 /¤

选定部分的上下文菜单 b

按箭头方向延伸选择 g任意箭头键

Python 编辑器和 Shell: 缩进当前行或所选行上
的文本或在内联提示之间进行导航

e

在文档中导航

显示上一页 /¡

开始使用 TI-Nspire™ CX II手持设备 11



12 开始使用 TI-Nspire™ CX II手持设备

显示下一页 /¢

显示 Page Sorter /£

退出 Page Sorter / 6

在拆分页上的应用程序之间切换 /e

在页面内后移焦点

Python 编辑器和 Shell: 取消缩进当前行或所选
行上的文本或在内联提示之间向后导航

ge

向导和模板

在矩阵中的当前列后添加一列 g@

在矩阵中的当前行后添加一行

Python 编辑器和 Shell: 在当前行之后添加新行。

@

积分模板 g+

求导模板 g-

数学模板面板 t或/;

分数模板 /p

修改显示

增加对比度 /+

降低对比度 /-

电源关闭 /c

特定应用程序的快捷方式

记事本 /程序编辑器 /Python 编辑器 : 全选

测验 : 选择对话框中的所有项目

/A



程序编辑器 /Python 编辑器 : 检查句法并保存 /B

程序编辑器 /Python 编辑器 : 查找 /F

几何 /图形 : 隐藏 /显示输入行

列表与电子表格 /程序编辑器 /Python 编辑器 :
转至

/G

程序编辑器 /Python 编辑器 : 查找和替换 /H

计算器 /程序编辑器 /Python 编辑器和 Shell: 行
首

/8

计算器 /程序编辑器 /Python 编辑器和 Shell: 行
尾

/2

注 : 插入数学表达式框 /M

注 : 插入化学方程式框 /E

打开便签本 »

列表与电子表格 : 重新计算

程序编辑器 : 检查句法、存储程序并在计算器
中粘贴程序名称 ( 在清除计算器中的当前行后 )

Python 编辑器 : 检查句法，保存程序并在 Python
Shell 中执行

Python Shell: 重新运行上次运行的程序

/R

几何 /图形 /列表与电子表格 : 添加函数表格

程序编辑器 /Python 编辑器和 Shell: 添加 /移除注
释符号

/T

在页面上归组 /取消归组应用程序 /4 //6

开始使用 TI-Nspire™ CX II手持设备 13



14 使用便签本

使用便签本

便签本是 TI-Nspire™ CX 手持设备的一项功能，能使您快速：

• 计算数学表达式。

• 描绘函数。

打开和关闭便签本

▶ 在“主页”屏幕上，按»打开便签本。

初次打开便签本时，会出现一个空白页面，同时计算器处于活动状态。

▶ 按»即可在计算和图形页面之间切换。

▶ 按b查看 便签本计算或 便签本图形菜单。这些菜单是计算器和图形

应用程序 TI-Nspire™ 菜单的子集。要获取这些菜单的完整列表，请参阅相
关应用程序的文档。

▶ 按d关闭便签本。

使用便签本计算

在便签本 计算页面的输入行中输入一个数学表达式，然后按·计算该表
达式。输入后，表达式以标准数学计数法显示。

每个经过计算的表达式和结果都会成为便签本历史记录的一部分，显示在输
入行的上方。

输入简单数学表达式

注：若要输入负数，按v，然后输入数字。

假如您要计算

1. 选择工作区中的输入行。

2. 输入 2l 8开始列出表达式。

3. 按 ¢将光标移回基准行，然后输入下列内容完成表达式：

r 43p 12

4. 按·计算表达式。

表达式以标准数学计数法显示，其结果显示在页面右侧。



注：您可通过按/·而不是按·得到一个近似的小数结果。

按/·可得到近似结果。

注：结果格式也可以在设置中进行调整。有关自定义设置的更多信息，请参
阅配置 TI-Nspire™ CX手持设备。

从 Catalog(目录 )插入条目

您可以使用目录将函数和命令、符号和表达式模板插入输入行。

1. 按k打开目录。默认情况下会显示第一个选项卡，其中按字母顺序列出
了所有命令和函数。

2. 如果您要插入的函数显示在该列表中，可以选中该函数，然后按·将
其插入。

3. 如果该列表中没有显示您要插入的函数 :

a) 请按一个字母键，跳转到以该字母开头的条目处。

b) 按 ¤或 £，根据需要突出显示您要插入的条目。

c) 单击带编号的选项卡按类别列出各函数 :数学函数、符号、数学模板、
库对象和标准度量单位的值。

d) 按·将该条目插入输入行。

使用表达式模板

模板可帮助您输入矩阵、分段函数、方程组、积分、导数、乘积和其他数学表
达式。

例如，假如您要计算

1. 按t打开“模板”面板。

2. 选择 插入代数和模板。

使用便签本 15



16 使用便签本

在输入行上显示模板，其中所带的小块表示您可输入的元素。其中一个元
素旁边出现光标，表示您可为该元素输入一个值。

3. 使用箭头键将光标移至每个元素的位置，并为每个元素输入一个值或表
达式。

4. 按·计算表达式。

使用向导插入表达式

您可使用向导简化输入表达式的过程。向导中包含带标签的框，可帮助您在
表达式中输入自变量。

例如，假如您想让一个 y=mx+b 线性回归模型适用于以下两个列表 :

{1,2,3,4,5}
{5,8,11,14,17}

1. 按k1打开目录并显示函数的字母列表。

2. 在列表中单击，然后按L跳至以“L”开头的条目。

3. 必要时按 ¤突出显示 LinRegMx。

4. 如果未选中 Wizards On( 启用向导) 选项，按ee突出显示 Wizards On
( 启用向导) 。

5. 按·更改设置。

6. 再次按ee突出显示 LinRegMx。



非 CAS 或 Exact Arithmetic手持设备中的

LinRegMx 函数

CAS 手持设备中的 LinRegMx 函数

7. 按·。

向导打开，提供一个带标签的框，允许您输入每个自变量。

8. 在 X List( X 列表) 中输入 {1,2,3,4,5}。

9. 按e移至 Y List( Y 列表) 字段。

10. 在 Y List( Y 列表) 中输入 {5,8,11,14,17}。

11. 要在指定的变量中存储回归方程，请按e，然后将 Save RegEqn To( 将
RegEqn 保存至) 替换为函数的变量名( f1 到 f99) 。

12. 单击“确定 ”关闭向导，在输入行中插入表达式。

表达式是与语句一同插入的，用以复制回归方程和显示变量 stat.results，
其中将会包含结果。

LinRegMx {1,2,3,4,5},{5,8,11,14,17},1: CopyVar stat.RegEqn,f1: stat.results

使用便签本 17



18 使用便签本

然后便签本会显示 stat.results变量。

注 :您可复制 stat.results变量中的值，并将其粘贴到输入行中。

查看历史记录

每个经过计算的表达式和结果都会成为便签本历史记录的一部分，显示在输
入行的上方。

▶ 按 £或 ¤滚动查看历史记录。

将历史记录条目复制到输入行

您可快速将一个表达式、子表达式或历史记录中的结果复制到输入行。

1. 按 £或 ¤浏览历史记录，选择您要复制的条目。

2. 也可通过组合使用g和箭头键选择部分表达式或结果。



3. 按·复制选择内容，并将其插入输入行。

清除历史记录

在清除历史记录时，历史记录中定义的所有变量和函数均保留当前的值不
变。如果您错误地清除了历史记录，请使用“还原”功能。

▶ 单击“动作 ” 菜单中的“清空历史记录 ”。

—或—

按b15。

所有的表达式和结果均将从历史记录中清除。

编辑便签本表达式

虽然您无法编辑历史记录中的便签本 计算表达式，但是您可以从历史记录中
复制全部或部分表达式，并将其粘贴至输入行。然后，您可编辑输入行。

在输入行中插入元素。

1. 请按e、¡、¢、£或 ¤定位表达式中的光标。

光标会移至离您所按方向最近的有效位置。

2. 输入元素或从目录中插入。

选择部分表达式

您可删除、剪切或复制一个表达式的选定部分。

1. 按 ¡、¢、£或 ¤将光标移至表达式的起点。

2. 按住g并按 ¡、¢、£或 ¤进行选择。

- 若要删除选择，请按.。

- 若要将选择内容剪切到剪贴板，请按/X。

- 若要将选择内容复制到剪贴板，请按/C。

- 若要将选择内容粘贴到便签本新的输入行中，请按/V。

使用便签本绘图

1. 如果尚未打开，请按»打开 Scratchpad 的“图形”页面。

默认情况下显示输入行。输入行显示了输入关系时所必需的格式。默认的
图形类型为 Function，因此显示为 f1(x)= 格式。

使用便签本 19



20 使用便签本

如果未显示输入行，请按 Ctrl + G或按b23显示输入行，并为图形
输入一个表达式。

2. 请按b > Graph Entry/Edit (b > 图形输入/编辑) 并选择图形类型。

例如 :

• 若要绘制一个圆的方程式，请按b > Graph Entry/Edit > Equation >
Circle > (x-h)2 + (y-k)2 = r2 或按b3231。填写方程并按·画
圆。

• 若要绘制一个函数，请按b > Graph Entry/Edit > Function或按

b31。

输入行会变为显示指定图形类型的表达式格式。您可以为每种图形类型
指定多个关系。

3. 为该图形类型输入表达式和其他所需参数。

4. 按·绘制关系或按 ¤添加其他关系。如有必要，您可按b4在
Window/Zoom( 窗口/缩放) 菜单中选择一个工具并调整查看区域。

绘制关系时，输入行会消失，以显示一个整洁的图形视图。如果您选择或
跟踪一个图，输入行中会显示定义此图的关系。您可通过定义关系或选择
和更改图形来修改一个图。

如果绘制了多张图，会显示每张图的定义关系。对于每种类型，您可以定
义和绘制最多 99 个关系。

5. 使用b键浏览和分析关系，用以 :

• 跟踪关系。

• 计算关键点。

• 对游标赋予一个表达式中的变量。

查看表格

▶ 若要显示当前图所对应值的表格，按b > Table > Split-screen Table (b
> 表格 > 拆分屏幕显示表格) (b71)。



▶ 若要隐藏表格，单击拆分屏幕中的图形一侧，然后按b > Table > Remove
Table (b > 表格 > 删除表格) (b72)。您也可以按 Ctrl + T。

▶ 若要调整列的大小，可单击表格并按b > Actions > Resize (b > 操作 >
调整大小) (b11)。

▶ 若要删除列、编辑表达式或编辑表格设置，可单击表格并按b > Table
(b > 表格) (b2)。

更改坐标轴的外观

因为您使用的是图形，所以默认显示直角坐标系。您可通过以下方式更改坐
标轴的外观 :

1. 按b4并选择要使用的缩放工具。

2. 选择坐标轴并按/b2激活 Attributes( 属性) 工具。

a) 按 £或 ¤移至要更改的属性。例如，选择结束样式属性。

b) 按 ¡或 ¢选择要使用的样式。

c) 更改您工作时所需坐标轴的其他属性，并按·退出属性工具。

3. 手动调整坐标轴的比例尺和刻度线间隔。

a) 单击并按住一个刻度线，在轴上移动。两条轴的刻度线间距和数量均
增加( 或减少) 。

b) 若要调整一条轴上的比例尺和刻度线，按住g，然后在那条轴上抓
取和拖动刻度线。

4. 通过双击和输入新值更改轴的端点值。

5. 调整坐标轴的位置。若要在不更改大小和比例的情况下移动现有坐标轴，
单击并将其拖动到屏幕的空白区域，直到坐标轴到达所需位置。

6. 若要更改坐标轴的比例尺，请按b > Window/Zoom > Window Settings
(b > 窗口/缩放 > 窗口设置) (b41)。

输入您选择的值，替换 x-min、x-max、y-min、y-max、Xscale 和 Yscale 的当前
值，并单击 “确定 ”。
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22 使用便签本

7. 按b > View > Hide Axes (b > 查看 > 隐藏坐标轴) (b21) 以隐藏
或显示坐标轴。

• 如果页面上显示坐标轴，可选择此工具将其隐藏。

• 如果页面上未显示坐标轴，选择此工具将使其重新显示。

跟踪一个图

“图形跟踪”功能会跟踪所绘函数图、参数图、极坐标图、数列图或散点图中的
点。若要启用此跟踪工具 :

1. 按b > Trace > Graph Trace (b > 跟踪 > 图形跟踪) (b51)，以跟踪
模式在图中移动。

2. ( 可选) 若要更改跟踪的跟踪步长增量，请按b53。

输入一个不同的步长增量后，图形跟踪工具会按此步长大小在图形中移
动。

3. 使用图形跟踪可按以下方式深入了解图表 :

• 移动到一点并悬停以将跟踪光标移动到该点。

• 按 ¡或 ¢在函数图形中进行点到点移动。将显示每个所跟踪点的坐
标。

• 按 £或 ¤从一个图移至另一个图。该点的坐标将更新以体现跟踪的
新位置。跟踪光标位于新图形或图表中的特定点上，该点的 x值与之
前跟踪的函数或图形中最后识别的点的值最接近。

• 输入一个数字并按·将跟踪光标移动至图中距离输入值最近的独
立坐标点上。

• 当跟踪点到达您要标记的点时，通过按·生成在图形中驻留的固定
点。在您退出图形跟踪模式后，该点仍然驻留。

注 :

• 当移动到未在此函数上定义的某一点( 不连续) 上时，将显示 undef 字
符串，而不显示数值。

• 当您在最初可见的图形上跟踪时，屏幕将平移以显示被跟踪的区域。

4. 按d或选择其他工具退出图形跟踪。



计算关键点

您可以使用“分析图形 ” 菜单中的工具在函数图像的指定范围中计算关键点。
选择一个工具以计算零点、最小值或最大值、交点、拐点或者导数 (dy/dx) 或
积分。

1. 在“分析图形 ”菜单上选择您要查找的关键点。例如，若要查找零点，请按

b61。

非 CAS和
精确算法

CAS

零位 b61 b61

最小值 b62 b62

最大值 b63 b63

交点 b64 b64

拐点 不适用 b65

dy/dx b65 b66

积分 b66 b67

分析圆锥曲线 b67 b68

选定工具的图标将在工作区左上角显示。指向该图标以查看有关使用选
定工具的工具提示。

2. 单击您要搜索关键点的图形，然后再次单击，指出开始搜索此点的位置。

第二次单击时标出了搜索区域下限，将显示一条虚线。

注 :如果您想求出导数 (dy/dx)，请单击图上用于求出导数的那一个点( 数
值) 。

3. 按 ¡或 ¢移动标记搜索区域的虚线，然后单击您要停止搜索的点( 搜索区
域上限) 。

4. 在搜索起始点上按·。工具会将该范围变为阴影。
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如果您指定的搜索区域包括关键点，则会显示该点的标签。如果您更改已
确定关键点的图形，请检查关键点是否更改。例如，如果您在输入行中编
辑函数或操纵图表，图形与零位相交的点可能会发生变化。

标记的关键点在图形中仍保持可见。通过按d或选择其他工具，您可
以退出该工具。

处理便签本中的变量

便签本变量可在便签本计算和便签本图形中共享，但不会用于 TI-Nspire™ 文
档中。如果您将便签本变量和文档中的变量命名为同一个名称，那么除非您
试图在文档和便签本之间复制表达式，否则不会发生冲突。

保存便签本内容

您可以将便签本计算页面和/或便签本图形页面保存在一个 TI-Nspire™ 文档
中。

1. 按~，然后选择“保存至文档 ”(~A)。

2. 按·。

“保存至文档”对话框打开。

3. 选择一个或多个要保存的页面。

4. 如果已有文档打开，则可以选择新建文档或当前文档。

5. 单击“保存 ”。

• 如果您选择的是保存至当前( 打开) 的文档，则便签本页面将会添加至
该文档。

• 如果您选择的是将便签本页面保存至新的文档，则该页面将会转换为
未保存的文档。要保存文档：

- 按~ >“保存 ”。“另存为”对话框将会打开。

- 为文档输入一个名称。

- 选择“保存 ”保存新文档。



清除便签本内容

请完成下列步骤，将计算和绘图工作从便签本应用程序中删除。

1. 按~ > “清除便签本 ” (~B)。

2. 按·删除便签本内容。
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TI-Nspire™ CX II手持设备的文档处理

使用 TI-Nspire™ CX II 手持设备处理的所有工作都包含在一个或多个 TI-Nspire™
文档中，您可以与其他手持设备用户和使用计算机软件的用户共享这些文
档。

• 每个文档包含至少 1 个、最多 30 个问题。

• 每个问题包含至少 1 个页面、最多 50 个页面。

• 每页可以分成四个工作区。

• 每个工作区都可以包含以下任意一种 TI-Nspire™ 应用程序 ( 计算器、图
形、几何、列表与电子表格、数据与统计、记事本以及 Vernier
DataQuest™) 。

打开文档

1. 在“主页”屏幕中，选择“浏览”。

—或—

按2。

文件管理器将打开。

2. 导航至您要打开的文件。

• 按 ¤可突出显示文档名，然后按x或·可打开文档。

• 若文件在文件夹中，按 ¤可突出显示文件夹，然后按x或·可打
开文件夹。

3. 按~，打开文档菜单，访问可用来处理已打开文档的选项。

创建新文档

1. 在“主页”屏幕中，选择“新建”。

—或—

按1。



也可按/N。

将会打开新的文档，并显示应用程序列表。

注 :屏幕左上方的选项卡指示这是第一个问题的第一页。

2. 使用 ¤和 £突出显示您要添加到页面的应用程序，然后按·打开该
页面。

保存文档

要在“我的文档”文件夹中保存文件：

1. 按~，打开“文档”菜单，然后选择“文件 ”>“保存 ”。

注：您也可以按~14或/S保存文档。

“另存为”对话框将会打开。

如果您是首次保存该文档，系统会提示您选择要将文档保存到哪个文件
夹并给文档命名。默认文件夹为“我的文档”。

2. 为文档输入一个名称。
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3. 单击“保存 ”保存文档至“我的文档”文件夹。

将文档保存到不同的文件夹

要将文档保存到不同的文件夹：

1. 从打开的文档中，按~15。

“另存为”对话框将会打开。

2. 按ge，导航至现有文件夹的列表。将选中列表中的第一个文件夹。

3. 使用 ¤和 £可滚动查看文件夹列表。

4. 要选择并打开文件夹，请按x。

5. 为文档输入一个名称。

6. 单击 “保存 ”将此文档保存到所选文件夹。

将文档保存到新文件夹

要将文档保存到新文件夹：

1. 从打开的文档中，按~15。

“另存为”对话框将会打开。

À 新建文件夹图标

Á 输入新文件夹名称

2. 按e，直至亮显新建文件夹图标，然后按·，创建新文件夹。

新文件夹将添加到现有文件夹列表的底部。文件夹名称默认为“Folder1。”

3. 为新文件夹输入一个名称，然后按·保存。

4. 再次按·可打开文件夹。

“文件名”字段处于活动状态。

5. 为文档输入一个名称。

6. 单击 “保存 ”将文档保存在新文件夹中。

使用应用程序

使用应用程序的选项包括：



• 创建新文档并选择应用程序

• 将新页面和应用程序添加到打开的文档

• 将多个应用程序添加至文档中的页面

添加应用程序

有多种方式可将应用程序添加至页面：

• 创建新文档时，可以使用触摸板或相应的数字键从应用程序列表中选择
某个应用程序。

• 要向已打开的文档添加新页面和应用程序，请按/~，然后从列表
中选择应用程序。

例如，按2将图形应用程序添加至页面。此应用程序将在工作区打开。

您也可以按 c，然后通过单击下列应用程序图标，从“主页”屏幕选择某
个应用程序：

计算器

图形

几何

列表与电子表格

数据与统计

记事本
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Vernier DataQuest™

在一个页面使用多个应用程序

您最多可以向每个页面添加四个应用程序。

创建新文档时，它包含添加应用程序的空间。如果需要添加多个应用程序到
页面，您可以更改布局以容纳最多四个应用程序。

您可以选择作为菜单条目提供的标准布局，或自定义布局以适合您的需求。

选择标准页面布局

1. 按~52显示布局选项。

2. 按您所想要的布局对应的数字。

例如，按2可创建双窗格布局，竖直划分页面。

3. 按/e在窗格之间移动。窗格边线以粗体显示代表该窗格处于活动
状态。



4. 按b，然后按您要添加新窗格的应用程序对应的数字。例如，按4可
添加列表与电子表格应用程序。

注：如果您需要更改页面的布局以添加或删除应用程序，您可以随时进
行。删除应用程序时，选择首先要删除的应用程序。

创建自定义页面布局

如果标准布局不符合您的需求，您可以在页面上自定义分配给应用程序的空
间。

1. 按~5显示布局选项。

2. 按1选择自定义拆分选项。

标准布局将会显示，应用程序窗格之间有分隔线。使用分隔线中间的箭

头 ( ) 来调整窗格的大小。

TI-Nspire™ CX II手持设备的文档处理 31



32 TI-Nspire™ CX II手持设备的文档处理

3. 按 £、¤、¡或 ¢移动分隔线，调整布局中窗格的高度或宽度。

4. 按+或-选择已定义布局：

• 按-返回到整页布局。

• 按+一次可将布局从垂直布局切换到水平布局。按-可恢复垂直
布局。

• 按+两次可将第三个窗格添加至页面。多次按+可在带有三个窗
格的垂直和水平页面布局之间进行选择。

• 按+五次可将第四个窗格添加至页面。按-可在之前的布局选项
之间切换。

5. 按x或·接受布局尺寸。

6. 按/e在窗格之间移动。窗格边线以粗体显示代表该窗格处于活动
状态。

交换页面上的应用程序

如果您要更改含多个应用程序的页面上的应用程序位置，可以通过“交换”两
个应用程序的位置完成。

1. 按~5 Page Layout“页面布局” 4 Swap Application“交换应用程序”。

选定应用程序四周将闪烁黑色粗边框，Swap App 光标 é将显示在屏幕
上。

注：在双窗格页面布局上，选定应用程序会自动和另一窗格交换位置。按

x或· 完成交换。

2. 按 £、¤、¡或 ¢将光标定位到您要交换的应用程序上。

3. 按x或·完成交换。

注：按d可取消交换。



组合应用程序

要将四个应用程序页面组合为一个页面：

1. 选择序列中的第一个页面。

2. 从“文档 ”菜单，选择“页面布局 ”>“分组 ”。

按~57。

下一页将与第一页组合。页面布局会自动调整以显示组内的所有页面。

取消组合页面

要取消组合页面：

1. 选择已组合的页面。

2. 从“文档 ”菜单，选择 “页面布局 ”>“取消分组 ”。

—或—

按~58。

材料将变为每个应用程序的单个页面。

从页面删除应用程序

1. 单击您要删除的应用程序。

2. 从“文档 ”菜单，选择“页面布局 ”>“删除应用程序 ”。

—或—

按~55。

选定的应用程序即会被删除。

如果要撤消删除，键入Ctrl-Z。

使用应用程序菜单

您可以使用应用程序菜单选择处理特定应用程序的工具。每个应用程序都有
一个独有的菜单。

使用应用程序菜单

1. 从空白页上，按b显示应用程序菜单。

该菜单将显示您可以添加到页面的应用程序。
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2. 按您要添加到页面的应用程序的编号。例如，按4可添加列表电子表格
应用程序。

3. 按b可显示应用程序菜单，其中列出了处理当前应用程序的选项。

下例显示列表与电子表格应用程序菜单。



上下文菜单

上下文菜单会显示特定于选中对象或当前光标位置的选项。

使用上下文菜单

▶ 要从应用程序访问上下文相关菜单，请按/b。

在下例中，上下文菜单显示了列表与电子表格中选定单元格的可用选项。

处理问题和页面

您可以使用“文档”菜单上的选项：

• 保存文档

• 访问编辑功能，如还原、重做、剪切、复制、粘贴和删除

• 在页面之间移动并打开页面检视器视图以查看含多个页面的文档

• 修改页面布局、插入页面或问题、删除页面和更改设置

• 将问题、页面和应用程序添加至打开的文档

• 访问页面布局选项

添加问题至文档

通过将问题添加至文档，您可重用变量名。文档最多可以包含 30 个问题。要
添加新问题：

1. 按~41打开“插入”选项。
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包含一个页面的新问题即会添加至该文档。屏幕左上方的选项卡指示这
是第二个问题的第一页。

2. 按 b打开应用程序菜单，然后按要添加至新页面的应用程序所对应的
数字。

查看和重新排列文档中的页面

页面检视器以缩略图格式显示文档中的所有问题和每个问题内的所有页面。
您可以使用页面检视器重新排列和删除页面，从一个问题复制页面并将其粘
贴到另一页面，以及应用模板到页面。

使用页面检视器查看多个页面

虽然手持设备通常一次只显示文档内的一个页面，但页面检视器可让您以缩
略图格式，查看文档中的所有问题以及每个问题内的所有页面。您可以使用
页面检视器重新排列和删除页面，从一个问题复制页面，将其粘贴到另一问
题。

从文档打开页面检视器

▶ 按/£。



页面检视器屏幕将显示当前文档中的所有问题和页面。

重新排列问题中的页面

使用页面检视器( 按/£) 在含有多个页面的问题内移动一个页面：

1. 按 3 或 4 键选择您要移动的页面。

页面四周的粗边框指示它已被选定。

2. 按下并按住x或按/x直至捕捉光标 ÷显示。

3. 按 ¡、¢、£o 或 ¤ 将页面移至所需位置。

4. 按x或·完成移动。

注：您可以按d取消。

页面将移至问题内的新位置，计数器也随之调整。

复制页面至另一问题

要将页面从一个问题复制到同一文档内的另一问题：
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1. 按/£打开页面检视器。

2. 按 ¡、¢、£o 或 ¤ 选择您要复制的页面。

页面四周的粗边框指示它已被选定。

3. 按/C复制该页面。

4. 按 ¡、¢、£o 或 ¤ 在问题中选择您将粘贴页面的位置。复制页面将置于您
所选择的页面之后。

5. 按/V将页面粘贴到新位置。

页面将复制到问题内的新位置，计数器也随之调整。

注：如果页面所含变量的名称与新问题同名，将会发生冲突。请在需要时重
命名变量。

复制页面至另一文档

要将页面从一个文档复制到另一文档：

1. 按/£打开页面检视器。

2. 按 ¡、¢、£o 或 ¤ 选择您要复制的页面。

页面四周的粗边框指示它已被选定。

3. 按/C复制该页面。

4. 按c2打开我的文档。

5. 按 £和 ¤突出显示包含要粘贴页面的文档的文件夹。

6. 再次按 ¢ 可打开文件夹。

—或—

按b3。



7. 按 £和 ¤键突出显示该文档。

8. 按x或·打开该文档。o

9. 按/£显示页面检视器。

10. 按 ¡、¢、£o 或 ¤页面移至文档中的所需位置。

11. 按/V将页面粘贴到新位置。

页面将移至问题内的新位置，计数器也随之调整。

复制、粘贴和删除问题

您可以将单个问题从某一位置复制和粘贴到同一文档的其他位置或不同文
档。您也可以从文档删除问题。

复制和粘贴问题

要复制和粘贴问题：

1. 打开页面检视器。

按/£。

—或—

按~33。

2. 选择问题。如果有多个问题，您可以按b2折叠页面检视器，仅按照
编号和标题列出这些问题。

3. 按/C。

4. 转至您要显示问题的位置。
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5. 按/V。

复制的问题将会置于新位置。

删除问题

要从文档删除问题：

1. 从页面检视器选择该问题。

2. 按/X。

问题即会从文档删除。

重命名问题

重命名问题：

1. 在文档处于活动状态时，打开页面检视器。

按/£。

2. 选择问题名称。

3. 按/b。

4. 选择7 “重命名 ”并键入名称。

5. 按/S保存更改。

添加页面至问题

每个问题最多可以包含 50 页。要添加新页面至问题：

▶ 按/~或/I，添加空白页并选择某个应用程序

—或—

▶ 按c 显示“主页 ”屏幕并将光标停在要添加到新页面的应用程序上，
然后单击或轻击。

新页面即会添加到当前问题。



注：屏幕左上方的选项卡指示这是第二个问题的第二页。

在文档中的页面之间移动

选项卡最多显示三个页面。文档所含页面超过三个时，选项卡的左右两侧将
出现箭头。

使用箭头键在文档之间导航。

• /¡ 显示上一页。

• /¢ 显示下一页。

• /£显示页面检视器。

• /¤显示上一视图。

• 使用触摸板单击出现在选项卡任一侧的箭头，可显示包含三页以上文档
中的更多页面。

管理文档

我的文档是一个文件管理器，您可以在这里存储和组织您的文档。下例显示
“我的文档”屏幕，并对主要部分做了标注。在屏幕下方，您可以看到每个标
注部分的说明。
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À 展开的文件夹

Á 最新、未保存的文档

Â 折叠的文件夹

Ã 系统状态指示符

Ä 文件大小

浏览我的文档中的文件

打开我的文档：

▶ 按c2。

注：如果您在页面中工作，请按/£/£。

“我的文档 屏幕即会打开，显示手持设备上的所有文件夹和文件。



• 要按名称或大小排序，请单击列标题。再次单击可从升序改为降序。

• 要滚动浏览我的文档，单击或捕捉滚动条。

• 要展开单个文件夹，请指向该文件夹并单击文件夹图标或按/¢。要

折叠，请再次单击或按/¡。

• 要展开所有文件夹，请按b7。要折叠，请按b8。

重命名文件夹或文档

要重命名文件夹或文档：

1. 按 £和 ¤键突出显示您要重命名的文档或文件夹。

2. 按b2。

文档或文件夹名称即会突出显示。

3. 键入新名称并按·完成更改。

注：按d可取消。

创建文件夹

您可以使用两种不同的方式创建文件夹：

• 您可以在保存新文档时创建文件夹：“保存 ”和 “另存为 ”菜单命令可让您为
文档输入新的文件夹名称。

• 您可以直接从“我的文档”屏幕创建文件夹。按b1。键入新文件夹的

名称，然后按x或·添加。

文件和文件夹命名规则

文件夹名称必须唯一。文件和文件夹名称可以很长，可以包含几乎所有字
符，包括空格和标点符号。

注：如果您打算将这些文档传送到您的计算机，在 TI-Nspire™ 软件中使用，最
好使用您的计算机可以接受的名称。避免使用标点、\、/ 或符号。
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删除文档和文件夹

1. 按 £和 ¤突出显示您要删除的文档或文件夹。

2. 按/b6。

—或—

按.。

将会打开一个对话框，确认您想要删除该文件或文件夹。

3. 按x或·选择是。

该文档即会被删除。

复制文档和文件夹

使用复制/C和粘贴/V复制文档和文件夹。

要将文档复制到另一文件夹，请选择所需的文件夹，然后粘贴。



恢复已删除的文档

我的文档中执行的大多数操作都可以撤消。按/Z( 还原) 可取消上次操
作，直至恢复已删除文档。

关闭文档

1. 要关闭文档，请按~13。

—或—

按/W。

如果您更改了文档，系统会询问您是否要保存这些更改。

2. 单击 “是 ”保存文档，或单击“否 ”取消更改。

了解 TI-Nspire™ 工具

此部分概要介绍了在手持设备上处理 TI-Nspire™ 文档所需的工具，例如，变
量、目录、符号以及数学模板。

创建 TI-Nspire™ 变量

变量可以是应用程序内创建的对象或函数的任意部分或属性。可成为变量的
属性包括矩形的面积、圆的半径、电子表格单元格中包含的值或列的内容或
者函数表达式。当您创建变量时，它存储在问题的内存中。更多有关变量的
信息，请参阅使用变量一章。

使用目录

使用目录可访问 TI-Nspire™ 命令、函数、单位、符号以及表达式模板的列表。
命令和函数按字母表顺序排序。非字母开头的命令和函数都列在列表最后
( 例如，&、/、+、- 等) 。要打开目录：

1. 在打开的文档中按k可打开目录。

2. 按与相应选项卡对应的数字键。
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例如，按2会显示数学函数列表。

3. 按 6，直到要插入的项已亮显。

屏幕底部会显示选中项目的语法示例。

注：要查看更多选中项目的语法示例，请按e，然后按·，最大化或

最小化“帮助”。要返回选中的项目，请按ge。

4. 按·插入该项。

关于目录窗口

目录窗口使用这些选项卡对文档中的命令、特殊字符以及模板进行分类：

包含所有按字母顺序排序的命令和函数

包含所有数学函数

提供标准度量单位的值

提供符号面板以添加特殊字符

包含创建二维 对象的数学模板，例如，乘积、求和、平方根以及积分

显示公共库 (LibPub) 对象

使用向导

一些目录功能使用向导帮助您输入函数自变量。要使用向导，请按e，直

至“向导开启 ”框已亮显。按x 或 ·，选中复选框。

输入特殊字符

符号面板包含了目录中现有对象的子集。要打开符号面板：



1. 在打开的文档中按/k。

2. 按 ¡、¢、£ o 或 ¤，选择符号。

3. 按·插入符号。

输入数学表达式

使用数学表达式模板创建二维对象，例如，求和、积分、导数以及平方根。要
打开数学表达式面板：

1. 在打开的文档中按t。

2. 按 ¡、¢、£ o 或 ¤，选择表达式。

3. 按x 或 ·插入表达式。

输入国际语言字符

在诸如记事本这种可以输入文本的应用程序中，可使用;键输入带重音或
加注标点的字符。

1. 打开可以输入文本的应用程序，例如记事本。
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2. 输入所需的文本。

3. 将光标停在要加重音符号的字母后。例如，在法语中为 “e”。

在小键盘上按;。请注意，此时，“e” 变成了“é”。继续按;，直到变成所需

的重音模式。按_或文本的下一个字母，接受此字符并继续输入。



使用图像

TI-Nspire™ 应用程序将图像用于参考、评估和教学用途。您可以为以下 TI-
Nspire™ 应用程序添加图像：

• 图形与几何

• 数据与统计

• 记事本

• 问题( 包括快速调查)

在“图形与几何”和“数据与统计”应用程序中，图像在轴和其它对象之后的背
景中设置。在“记事本”和“问题”应用程序中，图像在与文本一致的光标位置
设置( 在前景) 。

您可以插入以下类型的图像文件：.jpg、.png 或 .bmp。

注意：不支持 .png 文件类型的透明功能。透明背景显示为白色。

使用手持设备上的图像

手持设备上的图像可以从一个文档复制到另一个文档，或者在文档内调整其
大小或重新定位。也可以从文档中删除图像。

在手持设备上使用时，不可以在文档中添加或插入图像。但是，您可以将包
含图像的文档从计算机上转移到手持设备上。

注 :如果手持设备的存储空间不足，不能容纳包含图像的文档，则会显示错误
信息。

复制图像

执行以下步骤可将图像从一个文档复制到另一个文档，或者从同一文档的一
个页面复制到另一个页面。

1. 打开包含您想要复制的图像的文档。

2. 选择图像。

• 在“问题”或“记事本”应用程序中，将光标移动至图像上方，并按x。

• 在 Graphs & Geometry( 图形与几何) 应用程序中，按b122。

• 在 Data & Statistics( 数据与统计) 应用程序中，按b36。

图像周围出现边框。

3. 按/b，然后单击 Copy( 复制) 。您也可以按/C。

4. 打开您想要将图像粘贴到的文档，或在当前文档选择一个页面。

注 :如果您打开新文档，将会提示您保存和关闭当前文档。

5. 按/V。

使用图像 49



50 使用图像

注 :如果要将图像粘贴到 Graphs & Geometry( 图形与几何) 应用程序中，请

按·，然后按/V。

图像就复制到了该文档的页面内。

重新定位图像

执行以下步骤，重新定位页面中的图像。

1. 打开文档，并导航至包含该图像的页面。

2. 选择图像。

• 在“问题”或“笔记本”应用程序中，将光标移动至图像上方，然后按住再

释放x。该图像变暗。

• 在 Graphs & Geometry( 图形与几何) 应用程序中，按b122。

• 在 Data & Statistics( 数据与统计) 应用程序中，按b36。

图像周围出现边框。

3. 移动图像。

• 在“问题”或“笔记本”应用程序中，将光标移动至新的位置，然后按

x。

• 在“图形与几何”或“数据与统计”应用程序中 :

- 按住x直至光标变成四个箭头 ( )。图像在背景上浮动，边框
变成虚线。

- 在触摸板上移动手指，将图像移动到新的位置，然后按x或·
来放置图像。

调整图片大小

执行以下步骤以调整页面内图像的大小。

1. 打开包含图像的文档。

2. 选择图像。

• 在“问题”或“记事本”应用程序或“快速调查”中，将光标移动至图像上

方，按住然后释放x。该图像变暗。

• 在 Graphs & Geometry( 图形与几何) 应用程序中，按b122。

• 在 Data & Statistics( 数据与统计) 应用程序中，按b36。

图像周围出现边框。

3. 将光标移动至边框一角。

光标变成指向四个方向的箭头 ( )。



注 :如果您将光标移到图像某一边缘，则光标变成指向两个方向的箭头。
您可以左右拖动图像，调整其大小，但是这样图像就会变形。

4. 按x。

启用 工具。

5. 在触摸板上向任意方向移动手指，以调整图像大小。

出现的虚线表示新的尺寸。

6. 要接受新尺寸，请按x或·。

删除图像

执行以下步骤以从页面中删除图像。

1. 打开包含图像的文档。

2. 选择图像。

• 在“问题”或“笔记本”应用程序中，将光标移动至图像上方，然后按住再

释放x。该图像变暗。

• 在 Graphs & Geometry( 图形与几何) 应用程序中，按b122。

• 在 Data & Statistics( 数据与统计) 应用程序中，按b36。

图像周围出现边框。

3. 按/b，然后选择 Delete( 删除) 。

图像则会删除。

注 :在“问题”或“笔记本”应用程序中，您也可以按.删除选定的图像。
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在安装了 TI-Nspire™ CX Premium Teacher Software的
教室中工作

如果您所在教室采用了 TI-Nspire™ CX Premium Teacher Software，则须登录至班
级，以便与教师的计算机进行通信。教师可以通过以下方式与您的手持设备
进行通信：

• 发送文件

• 收集文件

• 删除文件

• 发送快速调查和接收快速调查答案

教师还可以暂停和重新启动您的手持设备。班级暂停时，您的手持设备上将
收到一条消息。教师退出暂停模式之前，您将不能使用手持设备。

使用无线通信硬件

在教室中使用 TI-Nspire™ CX 高级教师软件的教师可以将无线底座和/或无线
收发模块连接至学生的 TI-Nspire™ CX 手持设备上。然后，这些手持设备可以
无线链接到已连接至教师计算机的无线接入点。

您可以将以下任何设备连接至 TI-Nspire™ CX 手持设备 :

• TI-Nspire™ CX 无线收发模块 - v2( 2.4 GHz 或 5.0 GHz 频段)

• TI-Nspire™ 无线收发模块 (2.4 GHz)

连接无线收发模块至 CX 手持设备

注 :手持设备中的电池为无线收发模块供电。

1. 将无线收发模块置于手持设备顶部，以便模块上的连接器与手持设备顶
部的连接器对齐。

无线收发模块( 属学校所有)

连接器

与手持设备对齐的

导轨

2. 将无线收发模块滑动到位，确保模块端的导轨滑入手持设备端的槽中。



手持设备侧视图

对准无线收发模块

的凹槽

3. 用力按入无线收发模块，将模块安装到手持设备上，如下图所示。

注 :TI-Nspire™ CX 手持设备可以通过连接的无线收发模块充电。

连接到 TI-Nspire™ CX Navigator™ 系统

要连接到 TI-Nspire™ CX Navigator™ 网络，您必须先从手持设备登录到网络。登
录前，教师必须先完成以下任务：

• 在计算机中开始一个班级会话。

• 提供班级网络名称、用户名称和密码( 如有必要) 。

注：若手持设备操作系统的版本为 3.2 或更高，请使用此方法登录网络。

登录到网络

1. 将无线收发模块或无线底座连接到手持设备。

2. 确保 TI-Nspire™ CX II 手持设备可用于登录。( 图标正在闪烁。)

3. 完成以下操作之一：
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• 从“主页”屏幕中，按55。

• 从打开的文档中，按~8。

“登录到班级”对话框打开并显示上一次与该无线客户端关联的网络。

注：如果手持设备是通过 USB 线缆连接到计算机的，则屏幕上不会显示
网络名称，您可继续登录。

4. 若显示的网络名称正确，请单击登录。若网络不正确，请单击网络。

手持设备屏幕上会显示无线客户端上一次连接的网络，同时显示其他可
用网络。

5. 从列表中选择网络，然后单击连接。

登录屏幕显示连接状态，并在连接成功后显示网络名称。

6. 键入您的用户名和密码。

7. 选择登录。

“登录成功”屏幕打开。



8. 单击确定。

TI-Nspire™ 手持设备登录状态图标

TI-Nspire™ CX II 和 TI-Nspire™ CX II CAS 手持设备屏幕上的图标表示手持设备与
无线接收平台、无线收发模块、无线底座或 TI-Navigator™ 网络之间的通信状
态。图标表示的状态如下。

图标 状态 含义

闪烁 手持设备正在搜索无线接收平台。

稳定亮起 手持设备已找到无线接收平台。

稳定亮起 手持设备没有与无线收发模块或底座进行
通信。将手持设备与无线收发模块或底座
分离，等待该图标消失，然后将手持设备重
新连接到无线收发模块或底座。

闪烁 手持设备已连接到网络并可登录。

稳定亮起 手持设备已登录至网络。

了解文件传送

在班级会话期间，教师可以向学生的手持设备发送文件或者从学生的手持设
备收集或删除文件。

注 :在上课之前，教师可以设置发送或收集文件操作。当您登录时，文件将已
发送或收集完毕。如果教师同时设置发送和收集文件操作，则您将只能看到
最后完成的操作的对话框。

打开已发送的文件

当教师发送文件到您的手持设备时，手持设备上将打开“传送完成”对话框。
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▶ 单击“打开 ”可打开文件。如果教师发送多个文件，则会打开列表中的最后
一个文件。

注 :不管教师发送文件时的顺序如何，文件均是按名称字母顺序接收的。
列表中的最后一个文件是字母顺序排在最后的文件。

▶ 单击“转到 ”转到的手持设备上的文件发送位置。文件名会高亮显示。您可
以打开该文件或导航至其他文件。如果教师发送多个文件，则列表中字母
顺序排在最后的文件会高亮显示。

▶ 单击 OK( 确定) 退出对话框且不打开文件。您的手持设备恢复到消息发送
时的状态。

收集或删除文件

教师可在班级会话期间从您的手持设备夹中收集或删除文件。例如，教师可
以收集家庭作业或在进行测验之前删除某些文件。当教师收集或删除文件
时，在您的手持设备上会收到一条消息。

▶ 单击 OK( 确定) 忽略此消息。



配置手持设备

本章提供执行以下操作所需的信息：

• 维护手持设备中使用的电池。

• 更改默认设置。

• 在教室使用手持设备时，连接无线模块。

检查电池状态

要检查手持设备中的 TI-Nspire™ 充电电池状态：

1. 按c。

主页 屏幕打开。

2. 按54( 设置 > 状态 ) 。

手持设备状态 对话框将打开。

电池状态显示在此处。

3. 单击 确定 或按·关闭窗口。

注：在打开的文档中按~74 (~ > 设置和状态> 状态 )。

给手持设备充电

要给手持设备中的 TI-Nspire™ 充电电池充电，请将其连接到以下三种电源中
的任意一种：

• 连接到计算机的标准 USB 线缆

• TI USB 墙壁充电器( 单独销售)

• TI-Nspire™ CX 集成管理平台 或 TI-Nspire™ CM 集成管理平台( 在教室环境
下)
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电池充满电的时间长短可能有所不同，不过正常情况下，充电约需六小时。
不必从手持设备中取出 TI-Nspire™ 充电电池即可对其充电。手持设备连接到
充电电源时，该手持设备可继续正常操作。

从计算机给电池充电

要从计算机给手持设备充电，必须安装 TI-Nspire™ USB 驱动程序。USB 驱动程
序是所有 TI-Nspire™ 软件都随附的标准配置，这些软件包括：

• TI-Nspire™ Premium Teacher Software

• TI-Nspire™ CAS Premium Teacher Software

• TI-Nspire™ Student Software

• TI-Nspire™ CAS Student Software

要下载包含驱动程序的软件，请转至 education.ti.com/software。

了解电源的优先顺序

当 TI-Nspire™ 充电电池充电完成，手持设备按如下顺序获取电源：

• 首先，使用连接的外部电源，例如：

- 通过标准 USB 线缆连接的计算机

- 认可的墙壁充电器( 单独销售)

• 其次，使用 TI-Nspire™ 充电电池

按正确、安全的方式弃置用过的电池

不要切割、穿刺电池或将其丢至火中。电池可能爆裂或爆炸，释放出有毒的
化学物质。请按照当地法规处置电池。

更改手持设备设置

使用 设置 菜单上的选项更改或查看以下设置：

• 更改语言

• 设置( 文档和图形与几何)

- 定义或恢复打开文档和便签本的设置

- 定义或恢复手持设备的默认设置

• 手持设备设置

• 状态

• 登录

注：不是所有选项都随时可用。不可用的选项会禁用。

打开 设置 菜单

▶ 从 主页 屏幕中，按5或使用触摸板选择 设置。

设置 菜单将会打开。



更改首选语言

完成以下步骤以更改首选语言：

1. 从 主页 屏幕中，按5或选择 设置 打开该菜单。

2. 从菜单中选择 更改语言 或按1。

更改语言 对话框将会打开。

3. 按 ¢打开下拉列表。

4. 按 ¤突出显示语言，然后按x或·进行选择。

5. 按e突出显示 确定 按钮，然后按x或·以保存语言选择。

自定义手持设备设置

手持设备设置选项可以自定义选项以适合您的需求。

• 字体大小( 小、中或大)

• 电源待机。( 1、3、5、10 或 30 分钟) 。

- 使用此选项可延长电池寿命。

- 默认情况下，手持设备在不活动状态持续三分钟后自动断电。

• 休眠( 1、2、3、4、5 天或从不)

- 使用此选项可延长电池寿命。

- 休眠时，手持设备会在内存中保存当前的工作。

- 再次打开手持设备时，系统会重新启动并打开保存的工作。

• 指针速度( 慢、标准或快)

• 自动变暗( 30、60 或 90 秒，2 分钟或 5 分钟) 。

• 启用轻触代替单击。

更改手持设备设置选项

1. 在 主页 屏幕按53 ( 设置 >手持设备设置 )。

“手持设备设置”对话框将打开。
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2. 按e直至突出显示所需的类别。

3. 按 ¢查看可能设置的列表。

4. 按 6 突出显示所需的设置。

5. 按x或·选择新的设置。

6. 在您更改了所有设置以适合您的需求之后，按e直至突出显示 确定，

然后按x或·应用您的更改。

注：单击 恢复 可将手持设备恢复至出厂设置。

自定义文档设置

在 TI-Nspire™ 文档和 Scratchpad 中，文档设置可对手持设备如何显示及解读信
息进行控制。所有数字，包括矩阵和列表中的元素，都按文档设置显示。您可
以随时更改默认设置，还可以指定用于特定文档的设置。

文档设置及其可能的值在下表中列出。

字段 值

显
示
数
位

• 浮点

• 浮点 1 - 浮点 12
• 定点 0 - 定点 12

角
度

• 弧度

• 度数

• 百分度



字段 值

指
数
显
示
形
式

• 常规

• 科学

• 工程

实
数
或
复
数

• 实数

• 直角坐标

• 极坐标

计
算
模
式

• 自动

• 准确

• 近似值

注 :自动模式会将不是整数的答案显示为分数，除非问题中使用了
小数。Exact 模式( 仅 CAS) 会将不是整数的答案显示为分数或符号形
式，除非问题中使用了小数。

精
确
算
法

• 开启

• 关闭

注 :此选项仅对 Exact Arithmetic 手持设备可用。

CAS
模
式

• 开启

• 精确算法

• 关闭

注 :此选项仅对 CAS 手持设备和软件可用。

向
量
形
式

• 直角坐标

• 柱面坐标

• 球面坐标

进
制

• 十进制

• 十六进制

• 二进制

单
位
制

• SI
• 英制 /美制

注 :此选项仅对 CAS 手持设备和软件可用。

更改默认文档设置

完成下列步骤定义 TI-Nspire™ 文档和便签本的默认文档设置。

配置手持设备 61



62 配置手持设备

1. 保存并关闭所有打开的文档。

2. 从 Home( 主屏幕) 按52 (Settings > Document Settings)( 设置 > 文档设
置) 。

“文档设置”对话框打开。

ExactArithmetic操作系统 CAS操作系统

3. 按e可在设置列表中移动。按 £可在列表中反向移动。

有粗体线围绕的方框表示该框处于活动状态。

4. 按 ¢打开下拉菜单，查看每个设置的值。

5. 按 £和 ¤键突出显示所需的选项，然后按x或·选择值。

6. 单击 OK( 确定) 将所有设置保存为默认设置，这些设置将应用到所有新的
TI-Nspire™ 文档和 Scratchpad。

更改 TI-Nspire™ 文档中的文档设置

完成以下步骤以更改打开的 TI-Nspire™ 文档的文档设置。这些设置也将应用
于 Scratchpad( 便签本) ，并作为所有新文档的默认设置。

1. 在打开的文档中按c52 (c > Settings > Document Settings)( c > 设置
> 文档设置) 。

“文档设置”对话框打开。

ExactArithmetic操作系统 CAS操作系统



2. 按e可在设置列表中移动。按 £ 可在列表中反向移动。

有粗体线围绕的方框表示该框处于活动状态。

3. 到达所需的设置后，按 ¢ 打开下拉列表，查看每个设置的值。

4. 按 5 和 6 键高亮显示所需的选项，然后按x或·选择值。

5. 单击 OK( 确定) 或按x或·将新设置应用到打开的文档，并将其设置
为新文档和 Scratchpad 的默认设置。

恢复文档设置

完成以下步骤，将原始出厂设置还原到打开或新建的文档和 Scratchpad( 便签
本) 。

1. 在 Home( 主屏幕) 中，按58 (Settings > Restore Factory Defaults)( 设置 > 恢
复到出厂默认值) 。

“恢复默认值”对话框将打开。

2. 单击“确定 ”可将设置还原为出厂默认设置。

3. 按d或单击 Cancel( 取消) 返回 Home( 主页) 屏幕，而不进行任何更改。

自定义图形与几何设置

图形与几何的设置，可以控制信息在打开的问题以及后续新问题中的显示方
式。自定义应用程序设置后，您的选项将成为图形与几何应用程序中所有工
作的默认设置。

按照以下步骤更改图形与几何设置并将这些设置设定为所有新图形与几何
文档和便签本的默认值。

1. 打开已激活图形或几何应用程序的文档。

2. 按b9(b > 设置 ) 。

“图形与几何设置”对话框将打开。
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3. 按e可在设置列表中移动。单击 ¢打开下拉列表，查看每个设置的值。

字段 值

显示数位 自动

浮点

浮点 1 - 浮点 12
定点 0 - 定点 12

图形角度 自动

弧度

度数

百分度

几何角度 自动

弧度

度数

百分度

网格 无网格

点网格

线纹网格

4. 按 ¤查看值，然后按x或·选择值。

5. 在对话框的下部，选择复选框以启用选项，或清除复选框以禁用选项。

复选
框

选中后的操作

自
动
隐
藏
绘

绘图标签仅在将指针悬浮在图表上、选中或捕捉图表时才显
示。



复选
框

选中后的操作

图
标
签

显
示
坐
标
轴
端
值

在轴上可见的最小和最大值处显示数值标签。

显
示
函
数
处
理
的
工
具
提
示

处理函数图像时显示有用信息。

自
动
查
找
关
键
点

在跟踪函数图像时，显示已绘制函数和对象的零点、最小值和
最大值。

强制
使
几
何
三
角
形
的
角
度
为
整
数

在创建或编辑三角形时，将三角形的角度限制为整数值。此设
置仅适用于几何角度单位设置为 “度数 ”或 “百分度 ”的几何视
图。其不适用于 “绘图视图 ”中的分析三角形或 “几何视图 ”的分
析窗口中的分析三角形。此设置不影响现有角度，基于以前插
入的点来构建三角形时则不适用。默认情况下，此设置取消选
中。
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复选
框

选中后的操作

标
注
点

在绘制时，将标注 ( A、B、..., Z、A1、B1 等 ) 应用到点、线和几何
图形的顶点。文档中各页的标注顺序都开始于 A。默认情况
下，此设置取消选中。

注 :如果使用现有非标注点创建新对象，在完成的对象中不能
自动标注这些点。

6. 请选择以下选项之一 :

• 要将设置仅应用到打开的文档，请单击“确定 ”。

• 单击“取消 ”关闭对话框，不做任何改动。

查看手持设备状态

手持设备状态 屏幕提供关于手持设备当前状态的以下信息 :

• 充电电池的电池状态

• 软件版本

• 存储容量和可用存储量

• 网络( 如果有)

• 您的学生登录名以及您是否登录

• 关于

打开“手持设备状态”屏幕

1. 在“主页”屏幕按54( 设置 > 状态 ) 。

“手持设备状态”屏幕将打开。

2. 按“确定 ”关闭“手持设备状态”窗口。



查看手持设备详细信息

“关于”屏幕提供关于手持设备类型、操作系统 (OS) 版本和产品 ID 的附加信
息。

1. 在“主页”屏幕按54( 设置 > 状态 ) 。

“手持设备状态 ”屏幕将打开。

2. 单击关于以查看 关于手持设备的 详细信息。

3. 单击“确定 ”关闭“关于”对话框。

4. 单击“确定 ”返回至“主页”屏幕。

更换 TI-Nspire™ 充电电池

当您更换电池时，请完成以下步骤，将 TI-Nspire™ 充电电池装入手持设备。

注 :您的手持设备与图示可能并不完全相同。

1. 使用小螺丝刀松开手持设备后面的面板。

2. 卸下面板。
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3. 卸下旧电池。

4. 将充电电池装入电池仓内。

5. 装回后面板，并使用螺丝刀拧紧。

充电电池的注意事项

• 请不要将电池暴露在超过 60¡C (140¡F) 的高温环境中。

• 请不要拆卸或破坏电池。

• 仅使用推荐的电池充电器，或随原设备附送的充电器。

• TI 建议您使用此计算器随附的 USB 线缆。如果您选择使用第三方电源适
配器连接 TI 提供的 USB 线缆，应使用符合适用的安全和操作标准并获得
认证( 包括 UL 和 CE 认证) 的适配器。

更换充电电池时要注意以下注意事项 :

• 仅能用 TI 认可的电池进行更换。

• 未使用或未充电时，将电池从充电器或交流电适配器中取出。

• 将电池用于其他设备可能导致人员受伤及设备或财产损失。

• 不要混用不同品牌或同一品牌不同类型的电池。如果更换了错误类型的
电池，则存在爆炸风险。



弃置电池

不要切割、穿刺电池或将其丢至火中。电池可能爆裂或爆炸，释放出有毒的
化学物质。请按照当地法规处置电池。
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连接手持设备和传送文件

本章介绍如何将一台 TI-Nspire™ CX II 手持设备连接到另一台 TI-Nspire™ 手持设
备、如何将手持设备连接到计算机以及如何在它们之间传送文件。

TI-Nspire™ 手持设备有一个 USB 端口，可以用来连接另一台 TI-Nspire™ 手持设
备或计算机。

连接手持设备

您可以使用 USB 线缆连接两台 TI-Nspire™ 手持设备，或者将 TI-Nspire™ 手持设
备与计算机相连接。

用于连接两台 TI-Nspire™手持设备的 TI-Nspire™
手持设备微型 USB 线缆。

用于将手持设备连接到计算机的 TI-
Nspire™ USB 连接线缆。

使用微型 USB 线缆连接两台 TI-Nspire™ 手持设备

握持 TI-Nspire™ CX II 手持设备，并且屏幕朝

向自己时，USB 端口位于手持设备顶部右

侧。

1. 将微型 USB 线缆的一端牢牢插入 USB 端口。

2. 将线缆的另一端插入接收方手持设备的 USB 端口。



将 TI-Nspire™ 手持设备连接到计算机

1. 将线缆的微型 USB 端牢牢插入手持设备顶部的端口。

2. 将线缆的 USB 端牢牢插入计算机的 USB 端口。

在手持设备之间传送文件

您可以发送文档、操作系统 (OS) 文件和文件夹至其他 TI-Nspire™ 手持设备。

注 :TI-Nspire™ CX 手持设备必须运行 v4.5.1 或更新版本的操作系统，才能与 TI-
Nspire™ CX II 手持设备进行文件传送和接收。

传送文件或文件夹的规则

• 您可以传送文档和操作系统文件。

• 不同的手持设备类型之间不能交换操作系统。例如，您不能将 CAS 操作系
统传送至非 CAS 手持设备。

• 如果正在发送的文档与接收方手持设备上已经存在的文档重名，则发送
的文档将被重命名。系统会在文档名后附加一个数字使其成为唯一的文
档名。例如，如果接收方手持设备上已经存在 Mydata，它将被重命名为
Mydata(2)。

发送方和接收方手持设备都将出现一条消息，显示新名称。

• 文件名最大长度为 255 个字符( 含整个路径) 。如果所传送文件与接收方
手持设备上的现有文件重名，并且文件名包含 255 个字符，则所传送文件
的名称将遵循上文描述的重命名办法被截断。

• 与所传送文档关联的所有变量都会随文档传送。

• 传送将在 30 秒后超时，中止连接。

注意 :部分老式 TI-Nspire™ 手持设备无法接收文件夹，只能接收文件。如果在
向老式 TI-Nspire™ 手持设备发送文件或文件夹时出错，请参阅常见的错误和
通知消息。

发送文档或文件夹到其他手持设备

1. 确保已连接好两台手持设备。

2. 打开“我的文档”文件浏览器并导航至要传送的文件或文件夹。

3. 按触摸板上的 5 和 6 键突出显示要发送的文档或文件夹。

4. 按~16从 Documents( 文档) 菜单中选择 Send( 发送) 。

5. 文件传送即会开始。进度条会显示传送的状态。Sending...( 正在发送 ...) 对
话框上还有取消按钮，您可以取消正在进行的传送。

成功结束传送时，将显示消息
显示“<Folder / File name> 传送为 <Folder / File name> 。” 如果文件必须在接
收方手持设备上重命名，则该消息将显示新的文件名。

连接手持设备和传送文件 71



72 连接手持设备和传送文件

接收文档或文件夹

接收方 TI-Nspire™ 手持设备用户无需执行任何动作。连接线缆后，手持设备将
会自动开机。

成功结束传送时，将显示消息“<Folder / File name> 已接收。” 。” 如果文件必须
重命名，则该消息将显示新的文件名。

注意 :部分老式 TI-Nspire™ 手持设备无法接收文件夹，只能接收文件。如果在
向老式 TI-Nspire™ 手持设备发送文件或文件夹时出错，请参阅常见的错误和
通知消息。

取消传送

1. 要取消正在进行的传送，请在发送方手持设备上按 Cancel( 取消) 。任一方

手持设备用户也可以按d。

2. 按d或·取消传送错误消息。

在计算机和手持设备之间传送文件

在文档工作区中，教师和学生可以使用“拖放”方式快速从计算机向手持设备
或从手持设备向计算机传送文件和文件夹。

注 :您必须运行 v5.0 或更新版本的 TI-Nspire™ 软件，才能与 TI-Nspire™ CX II 手持
设备进行文件传送和接收。

1. 使用标准 A 转微型 B USB 线缆将手持设备连接到计算机。

2. 在 TI-Nspire™ 软件中，打开 Documents Workspace( 文档工作区) 。

3. 在 Documents Toolbox( 文档工具箱) 中，单击 打开 Content Explorer( 内容
浏览器) 。



计算机面板

已连接的手持设备

4. 导航至包含您要传送的文件的文件夹。

• 要将文件从手持设备传送到计算机，请单击该文件，然后将其拖放到
计算机面板中的文件夹内。

• 要将文件从计算机传送到手持设备，请单击该文件，然后将其拖放到
已连接的手持设备中。

注 :使用 TI-Nspire™ CX Premium 高级教师软件或 TI-Nspire™ Navigator™ 教师软件
的用户还可以通过 Content Workspace( 内容工作区) 中的选项将文件从手持设
备传送到计算机。

使用 Save to Handheld( 保存至手持设备) 选项

如果要将文件保存到手持设备上的特定文件夹，您还可以在文档工作区中使
用文件菜单的“保存至手持设备”选项，将文件传送至已连接的手持设备。
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1. 确保手持设备已连接到计算机。

2. 在计算机面板中，导航至文件所在的文件夹。

3. 单击文件。

4. 单击 File > Save to Handheld( 文件 > 保存至手持设备) 。“保存至手持设备”对
话框将打开。

5. 双击手持设备名称，然后导航至您要保存文件的文件夹。

6. 单击保存。文件将保存到选定的文件夹中，Save to Handheld( 保存至手持设
备) 对话框将关闭。

处理发送文件夹所导致的错误

如果您在尝试发送文件后收到错误消息，这可能表示接收方手持设备的操作
系统不支持传送。要解决此问题，请更新接收方手持设备的操作系统并重新
发送。

常见的错误和通知消息

显示
位置

消息和说明

发
送
方
手
持
设
备

“接收方手持式设备不支持此文件夹结构。接收方手持式设备的操作系
统可能需要更新，您可通过选择 My Documents(我的文档)菜单下的

Send OS(发送操作系统)来进行更新。”
确定

如果在向老式 TI-Nspire™ 手持设备发送文件夹时出错，请尝试更新接收
方手持设备上的操作系统。如果错误依旧存在，您可能必须单独发送
各个文件。

发
送
方
手
持
设

“传送失败。请检查线缆，然后重试。”
确定



显示
位置

消息和说明

备
没有将线缆连接到发送方手持设备的连接端口时会显示此消息。取下
并重新插入线缆，然后再次尝试文档传送。

单击 OK( 确定 ) 取消传送消息。

注 :发送方手持设备可能不总显示此消息，而是保持 “忙 ”状态，直至您
取消传送。

发
送
方
手
持
设
备

“接收方存储空间不足，无法进行文件传送。”
确定

此消息指示接收方手持设备没有足够的存储空间接受正在传送的文
件。

接收方手持设备用户必须释放空间才能获取新文件。要执行此操作 :
• 删除不需要的文件。

• 将文件储存到计算机中以备后续取回，然后将其从 TI-Nspire™ 手持
设备上删除。

发
送
方
手
持
设
备

“<folder>/<filename> 传送为 <folder>/<filename(#)。”

成功结束传送，但由于接收方手持设备上已经存在同名文件，因此不
得不重命名传送文件时显示此消息。所传送的文件将通过在文件名后
附加一个数字进行重命名。重命名编号总是从 (2) 开始，并根据需要以
1 为增量递增。

发
送
方
手
持
设
备

“<folder>/<filename> 传送为 <folder>/<new filename>。”

此消息指示已在接收方手持设备上创建新文件夹，以容纳所传送的文
档。

接
收
方
手
持
设
备

“<folder>/<filename(x)> 已接收。”

此消息指示接收方手持设备包含与正在发送的文档同名的文档。

接
收
方
手
持
设
备

“<new folder>/<new filename> 已接收。”

此消息指示已创建新文件夹，以容纳所传送的文档。

接 “传送失败。请检查线缆，然后重试。”
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显示
位置

消息和说明

收
方
手
持
设
备

确定

此消息指示没有将线缆正确地连接到接收方手持设备的连接端口。取
下线缆然后重新连接，并再次尝试传送。

单击 OK( 确定 ) 取消传送消息。



文件管理

TI-Nspire™ CX II-C 手持设备配有 128 MB 闪存。操作系统会使用部分存储，并且
随着时间的推移，在手持设备上保存新文档会进一步减少可用存储空间。要
避免或解决存储空间问题，请使用以下选项之一 :

• 删除不再使用的文档和文件夹。

• 将文件或文件夹备份至其他手持设备或计算机上。

• 重置存储，将手持设备上的所有文件和文件夹删除。

检查可用存储空间

完成以下步骤以查看手持设备上可用的存储空间( 以字节为单位) 。

1. 从主屏幕的设置菜单中，选择状态。

按c54。

“手持设备状态”窗口将随即打开。

2. 查看 Storage Available( 可用存储空间) 字段以确定手持设备有多少可用存
储空间。

3. 单击“确定 ”返回至“主页”屏幕。

释放存储空间

要释放或恢复存储空间，请从手持设备删除文档和/或文件夹。要保留文档和
文件夹以后使用，请使用 TI-Nspire™ 软件将它们传输到其他手持设备或计算
机上。

从手持设备删除文件

1. 按c2打开 My Documents( 我的文档) 文件浏览器。

2. 按 £或 ¤选择要删除的文件夹或文档。

3. 按.。

文件管理 77



78 文件管理

—或—

按/b6。

此时将打开对话框，询问您是否确认删除。

4. 按·确认或按d取消。

文件夹/文档将从手持设备上永久删除。

将文件备份至其他手持设备

1. 使用 USB 到 USB 连接线缆连接两台手持设备。

2. 在发送方手持设备上按c2打开 My Documents( 我的文档) 。

3. 按 5 和 6 键高亮显示要发送的文档。

4. 按b，然后选择 Send( 发送) 。

—或—

按/b2。

5. 文件传送结束后，接收设备会显示一条消息。

将文件传送至计算机

使用 TI-Nspire™ 软件将文件和文件夹从手持设备传送至计算机。

1. 使用标准 A 转微型 B USB 线缆将手持设备连接到计算机。

2. 在 TI-Nspire™ 软件中，打开 Documents Workspace( 文档工作区) 。

3. 在 Documents Toolbox( 文档工具箱) 中，单击 打开 Content Explorer( 内容
浏览器) 。



计算机窗格

“已连接的手持设备 ”窗格

4. 在 Computer( 计算机) 窗格中，导航至要保存文件的文件夹。

5. 在“已连接的手持设备”窗格中，双击手持设备名称以查看手持设备上的文
件夹和文件。
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6. 选择您要保存至计算机的文件或文件夹。

• 单击文件或文件夹，每次选择一个。

• 要选择手持设备上的所有文件，请选择列表中的第一个文件，按住
Shift 键，然后单击列表中的最后一个文件或文件夹。

• 要没有规则地选择多个文件，请单击第一个文件，然后按住 Ctrl 键并
选择更多文件。

注 :如果您选择了多个文件，它们将被保存为课程包 (.tilb file)。

7. 将这些文件拖到 Computer( 计算机) 窗格中的文件夹内。

—或—

选择 File > Save as( 文件  > 另存为) 。

这些文件将复制到计算机上的文件夹中。

8. 确认需要的文件已经在计算机上，然后将其从手持设备上删除。

注 :使用 TI-Nspire™ CX Premium 高级教师软件或 TI-Nspire™ Navigator™ 教师软件
的用户还可以通过 Content Workspace( 内容工作区) 中的选项将文件从手持设
备复制到计算机中。

重置存储

这些步骤只可在您要删除手持设备上的“所有”文件和文件夹时执行。

警示 :此操作会清除复制/粘贴剪贴板，清除 Scratchpad( 便签本) ，并从手持设
备中删除用户创建的所有文件和文件夹。您无法撤消此操作。继续之前，请
考虑仅删除选定数据来恢复足够的可用存储空间。

1. 确定您要清除所有文件后，按c2打开 My Documents( 我的文档) 文
件浏览器。

2. 按b打开上下文菜单。



3. 选择 Delete All( 全部删除) 。
—或—
按C。

Delete All( 全部删除) 对话框将打开。

4. 单击 OK( 确定) 确认您要清除手持设备存储。
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更新手持设备操作系统

为了使用最新的手持设备功能和更新，请从 Education Technology 网站
(education.ti.com) 下载最新的操作系统文件。您可以使用计算机和以下软件更
新 TI-Nspire™ 手持设备上的操作系统 (OS):

• TI-Nspire™ CX Premium Teacher Software( v5.0 和更高版本)

• TI-Nspire™ CX Student Software ( v5.0 和更高版本)

• TI-Nspire™ CX CAS Premium Teacher Software( v5.0 和更高版本)

• TI-Nspire™ CX CAS Student Software( v5.0 和更高版本)

• TI-Nspire™ CX Navigator™ Teacher Software

• TI-Nspire™ CX CAS Navigator™ Teacher Software

在教室中，您可以使用 TI-Nspire™ Docking Station 同时升级多台手持设备上的
操作系统，

也可以从一台 TI-Nspire™ 手持设备向另一台 TI-Nspire™ 手持设备传送操作系
统，或者从一台 TI-Nspire™ CX II 手持设备向另一台 TI-Nspire™ CX II 手持设备传
送操作系统。但是，不同类型手持设备的操作系统不能交换。您不能将 Exact
Arithmetic 或 CAS 操作系统传送到非 Exact Arithmetic 或非 CAS 手持设备上，也
不能将 TI-Nspire™ 手持设备操作系统传送到 TI-Nspire™ CX II 手持设备上。

您需要了解的内容

• 如果接收方手持设备上没有足够的空间进行升级，则会显示一条消息。有
关更多信息，请参阅文件管理。

• 操作系统升级操作不会删除用户文档。仅当接收方手持设备操作系统已
损坏时，文档才有可能受操作系统安装影响。在这种情况下，文档可能受
操作系统还原影响。较好的做法是在安装更新版操作系统之前，备份重要
的文档和文件夹。

准备工作

开始操作系统下载之前，确保电池至少有 25% 的电量。

▶ 要检查 TI-Nspire™ CX II-C 手持设备中可充电电池的状态，请按c54
打开 Handheld Status( 手持设备状态) 对话框。

处于操作系统下载模式时，Automatic Power Down™ (APD™) 功能不可用。如果
在开始下载前已让手持设备较长时间处于下载模式，则电池可能会耗尽，您
需要更换电池或重新充电才能下载操作系统。

查找操作系统升级

有关可用的操作系统升级的最新信息，请检查 Texas Instruments 网
站：education.ti.com。

您可以从 Texas Instruments 网站将操作系统升级文件下载到计算机上，然后
使用 USB 缆线将操作系统安装在您的 TI-Nspire™ CX II 手持设备上。您需要
Internet 连接和适当的 USB 线缆以下载更新。



检查手持设备操作系统更新

使用 TI-Nspire™ 软件时，将手持设备连接到计算机后，您可以迅速确定您的手
持设备操作系统是否是最新的。

1. 打开 TI-Nspire™ 软件并确保您的手持设备已经连接到计算机。

2. 在文档工作区中，单击 打开内容浏览器。

3. 在“已连接的手持设备”窗格中，选择一台已连接的手持设备。

4. 选择帮助 > 检查手持设备操作系统更新。

• 如果操作系统为最新，将显示“检查手持式设备操作系统更新”对话
框，指示手持式设备上的操作系统为最新。

• 如果操作系统不是最新的，对话框内将显示一条消息，指示有新版本
的操作系统可用。

5. 单击确定关闭对话框。

执行操作系统更新

在 TI-Nspire™ 软件中，您可以通过以下工作区和菜单选择升级已连接的手持
设备上的操作系统 :

• 在所有版本的软件中，您都可以选择帮助 > 检查手持设备操作系统更新。
在内容浏览器中选择已连接的手持设备以激活此选项。如果手持设备上
的操作系统不是最新的，对话框将指示有更新版本的操作系统。请按照提
示更新操作系统。

• 在所有版本的 TI-Nspire™ 软件中，您都可以使用文档工作区中的选项 :

- 打开内容浏览器，选择手持设备名称，然后单击 并选择 Install OS
( 安装操作系统) 。

—或—

- 选择工具 > 安装手持设备 /实验室底座操作系统。

• 使用教师版 TI-Nspire™ 软件的用户可以使用内容工作区中的选项 :

- 在资源窗格中，右键单击已连接手持设备的名称，然后选择 Install
Handheld/Lab Cradle OS( 安装手持设备/实验室底座操作系统) 。

—或—

- 在预览窗格中，选择手持设备名称，单击预览窗格中的 ，然后选择
Install Handheld/Lab Cradle OS( 安装手持设备/实验室底座操作系统) 。

—或—

- 右键单击手持设备名称并选择 Install Handheld OS/Lab Cradle OS( 安装手
持设备/实验室底座操作系统) 。
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完成操作系统升级

当您选择更新手持设备上的操作系统时，将显示 Select Handheld OS File( 选择
手持设备操作系统文件) 对话框。

默认显示将显示所选手持设备所要求的类型的文件，以供选择。

1. 选择操作系统文件 :

• 如果您升级 TI-Nspire™ CX II 手持设备，请选择 TI-Nspire.tco2
• 如果您升级 TI-Nspire™ CX II CAS 手持设备，请选择 TI-Nspire.tcc2
• 如果您升级 TI-Nspire™ CX II-T (Exact Arithmetic) 手持设备，请选择 TI-

Nspire.tct2

2. 单击 Install OS( 安装操作系统) 下载操作系统并更新手持设备。这时将显
示确认消息“即将升级您手持设备的操作系统。任何未保存的数据都将丢
失。是否继续？” 。”

3. 单击是继续。

“安装操作系统”对话框将打开，并显示下载进度。请勿断开与手持式设备
的连接。



4. 下载完成后，Information( 信息) 对话框将打开，指示操作系统文件已成功
传送至手持设备。您可以断开与手持设备的连接。

5. 单击确定。

更新的操作系统将安装到手持设备上。更新完成后，手持设备将重新启
动。

6. 在手持设备上，按照提示进行操作 :

• 选择首选语言。

• 选择首选字体大小。

7. 欢迎屏幕打开时，单击 OK( 确定) 。

主页屏幕将打开。

从另一台手持设备传送操作系统

注 :您无法将 TI-Nspire™ 手持设备上的操作系统传送到 TI-Nspire™ CX II 手持设
备，也无法将 Exact Arithmetic 或 CAS 手持设备的操作系统传送到非 Exact
Arithmetic 或非 CAS 手持设备。这些操作系统各不相同，不能互换。

将操作系统从一台手持设备传送至另一台 :

1. 确保已关闭接收方手持设备上的所有打开文档。

2. 使用 USB 微型 A 到微型 B 线缆连接两台手持设备。

3. 在发送方手持设备上，从主屏幕选择“浏览”。

4. 按b，然后选择 Send OS( 发送操作系统) 。
在 TI-Nspire™ 手持设备上，按b。
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5. 在接收方手持设备上将显示消息“您正在接收操作系统升级。未保存的更
改将丢失。是否要继续？”以及“是”和“否”响应按钮。选择“是”以接收操作
系统升级。

• 如果在 30 秒内没有选择 Yes( 是) ，手持设备将自动响应“否”，传送将
取消。

• 执行操作系统升级前，务必保存并关闭所有打开的文档。在打开未保
存文档的手持设备上继续操作系统升级会导致文档数据丢失。

6. 升级过程中，接收方和发送方手持设备将显示以下消息 :

• “正在接收操作系统。请勿拔出线缆。”
• “正在发送操作系统。请勿拔出线缆。”

7. 传送完成后，发送方手持设备将收到一条完成消息，这时您就可以取下线
缆了。操作系统会在接收方手持设备上自动安装。安装过程中，接收方手
持设备上将显示消息“正在安装 <版本号> 操作系统”。

8. 安装完成后，将显示消息“已安装 <version number> 版操作系统。手持设备
现在将重新启动。” 。这时重启会立即开始。如果发送方手持设备仍连接
在线缆上，该手持设备的屏幕将保持显示传送成功的消息。

重要信息 :

• 对于每个接收方手持设备，请记得根据需要备份信息和安装新电池。

• 确保发送方手持设备显示 Send OS( 发送操作系统) 屏幕。

升级多台手持设备上的操作系统

在教室中，可以使用 TI-Nspire™ CX 集成管理平台同时升级多台手持设备上的
操作系统。

在教师版 TI-Nspire™ 软件中，您可以通过内容工作区将文件从计算机传送到
多台手持设备。有关传送文件至已连接的手持设备的更多信息，请参阅使用
内容工作区。

操作系统升级消息

本部分列举操作系统升级过程中可能显示在手持设备上的信息和错误消息。

显示位
置 : 消息和说明

发送方
手持设
备

“接收方存储空间不足。让 <xxxK> 准备足够的空间。”

此消息指示接收方手持设备没有足够的存储空间接受新的操作系
统。其中显示了空间要求，这样您就知道必须为新的操作系统清除
多少存储。可以将文件移至计算机上保存以获得必要的可用空间。

发送方
手持设
备

“升级操作系统之前接收方必须更换电池。”

此消息指示需要更换接收方手持设备上的电池。更换电池后即可
发送操作系统更新。

发送方
手持设

“接收方的操作系统更新，因此无法
加载此操作系统。”



显示位
置 : 消息和说明

备 确定

此消息指示接收方手持设备上有比要传送的操作系统版本更新的
操作系统。您无法降级操作系统。

发送方
手持设
备

“接收方不接收升级。”
确定

此消息指示接收方手持设备拒绝升级。

发送方
手持设
备

“操作系统已传送。
您现在可以拔出线缆。”

确定

此消息指示传送已完成，可以安全地从发送方手持设备拔下线缆。

发送方
手持设
备

“正在发送操作系统。请勿拔出线缆。”

此消息与进度条一同在操作系统升级传送过程中显示。

发送方
和接收
方手持
设备

“传送失败。请检查线缆，然后重试。”
确定

发送方和 /或接收方手持设备连接不正确。将线缆重新插入每个手
持设备，然后再次尝试传送。

接收方
手持设
备

“您正在接收操作系统升级。未保存的更改将丢失。
是否要继续？”

是/否

此消息在操作系统升级即将开始时显示。如果您在 30 秒内没有选
择 “是 ”，系统将自动响应 “否 ”。

接收方
手持设
备

“正在接收操作系统。请勿拔出线缆。”

此消息与进度条一同在操作系统升级传送过程中显示。

接收方
手持设
备

“正在安装操作系统。”

传送完成后将显示此消息。显示此消息是为了通知您手持设备的
状态。

接收方
手持设
备

“已安装操作系统。手持设备将重新启动。”
确定

此消息在手持设备自动重启前短暂显示。

接收方
手持设
备

“安装不完整。手持设备将重新启动。您需要重试操作系统更新。”
确定

传送过程中出错，安装不完整。手持设备将重新启动。重启后，请重
新安装操作系统升级。
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TI-Nspire™ CX II Connect
TI-Nspire™ CX II Connect 是基于 Web 的应用程序，提供计算机和 TI-Nspire™ CX II
图形计算器之间的连接。它允许您进行计算器屏幕截图，将 .tns 文件传送到
计算器或从计算器进行传送，以及更新计算器上的操作系统。

系统要求

• 浏览器

- Google Chrome 90 或更高版本

- Microsoft Edge 90 或更高版本

• 计算机

- Chromebook
- Windows® 10
- Mac® OS 10.15 或更高版本

• 有效的互联网连接

• Web USB 已启用

• 访问共享内存、文件和剪贴板

支持的计算器

• TI-Nspire™ CX II

• TI-Nspire™ CX II CAS

• TI-Nspire™ CX II-T

• TI-Nspire™ CX II-T CAS

• TI-Nspire™ CX II-C CAS

TI-Nspire™ CX II Connect 快速入门

1. 打开兼容浏览器。

2. 在地址栏内输入 nspireconnect.ti.com。

如果出现提示，则点击同意并继续接受 Cookie，然后点击接受按钮同意 TI 
条款和条件。

应用程序加载时将执行兼容性检查。如果发现任何问题，将显示一个页
面，其中包含需要解决的问题信息。

https://nspireconnect.ti.com/


3. 在“让我们快速入门”页面加载后，将 TI-Nspire™ CX II 计算器连接到您的计
算机。

注 :如果您的计算机只有 USB-C 端口，则需要通过 USB-A 到 USB-C 适配器
连接计算器。

4. 点击连接至计算器。

5. 在弹出窗口中，单击计算器的名称，然后单击连接。

主页将打开，显示三个可用选项 :屏幕截图、文件传送和操作系统更新。
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在网站上导航

连接计算器后，有两种方法可在 TI-Nspire™ CX II Connect 网站上导航 :

• 链接到主页的每个页面左上角的 TI-Nspire™ CX II Connect 徽标

• 每个页面右上角的每个功能链接( 主页和“让我们快速入门”页面除外)

注 :如果您的计算器断开连接，然后重新连接( 或连接另一台计算器) ，您将被
重定向到“让我们快速入门”页面。

使用 Google Drive
注 :此功能为可选项。如果您使用 Google 登录，TI 不保存您的任何用户数据。

要使用您的 Google Drive 帐户保存屏幕截图或传送 tns 文件 :

1. 点击任意页面右上角的使用 Google 登录图标。

2. 在使用 Google 登录弹出窗口中，完成登录流程以连接至 Google Drive。



3. 当标准 Google Account 对话框显示提示时，选择复选框，授权对您的
Google Drive 的应用访问，以将文件传入至您的计算机，或将文件从计算机
传出。

成功登录后，登录图标将显示绿色复选标记，然后可用于登出您的 Google
Drive 帐户。

注 :使用 Google Drive 进行屏幕截图或文件传送时，必须首先创建要在
Google Drive 中使用的文件夹。

断开 Google Drive 的 TI-Nspire™ CX II Connect

1. 在 Google Drive 中，点击设置图标并选择设置。
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2. 在设置对话框中，点击管理应用程序。

3. 在列表中找到 TI-Nspire™ CX II Connect 应用程序，然后点击 选项 > 断开
Drive 连接。

4. 在确认对话框中，点击断开。

TI-Nspire™ CX II Connect 应用程序将从列表中移除。

5. 点击完成。

截取计算器屏幕

要截取计算器屏幕 :

1. 导航到屏幕截图页面。



2. 单击截取屏幕按钮。

将会显示当前的计算器屏幕。

注 :要截取另一个屏幕，请在计算器上进行必要的更改，然后再次单击截
取屏幕按钮。

3. 点击以下其中一个按钮 :

- 将当前屏幕复制到计算机剪贴板，并在其他应用程序中使用该图

片。

- 将当前屏幕内容保存至计算机。

- 将当前屏幕内容保存至 Google Drive。

注 :使用 Google Drive 进行屏幕截图或文件传送时，必须首先创建要在
Google Drive 中使用的文件夹。

传送文件

若要将文件传入至计算机或从计算机传出文件。

1. 导航至文件传送页面。
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2. 点击传出计算器或传入计算器，然后遵循以下相应说明。

注 :只能传送 .tns 文件。不会显示其他文件类型。此外，计算器上的文件必
须在“我的文档”文件夹内，而非子文件夹内。

将文件从计算器传送至计算机

从计算器上“我的文档”文件夹选择一个或多个文件发送至计算机。

注 :选中或取消选中«1»全选«2»框，以突出显示或清除所选文件。

要将文件传送至 Google Drive:

1. 单击传送至 GOOGLE DRIVE。

2. 点击您要保存文件的目标文件夹，然后点击选择。

注 :使用 Google Drive 进行屏幕截图或文件传送时，必须首先创建要在

Google Drive 中使用的文件夹。

注 :如果您传送 Google Drive 上已存在的文件，这些文件将被自动覆盖。



3. 当显示已发送文件列表时，您可以点击发送更多文件或返回链接，以选择

更多待传送文件。

若要将文件传送至计算机 :

1. 点击传送至计算机。

2. 点击您要保存文件的目标文件夹，然后点击选择文件夹。

3. 当提示让站点查看文件时，单击查看文件。

4. 当提示保存目标文件夹的更改时，点击保存更改。

注 :如果您要传送计算机上已存在的文件，则将创建文件的副本，并在文

件名后附加编号。

5. 当显示已发送文件列表时，您可以点击发送更多文件或返回链接，以选择

更多待传送文件。

将文件从计算机传送至计算器

1. 点击 从 GOOGLE DRIVE 传出 或 从计算机传出。

2. 定位并选择要传送的文件。

注 :如果您传送的是计算器上已存在的文件，则会创建一个文件副本，并

在文件名中附加一个编号。

3. 当显示已发送文件列表时，您可以点击发送更多文件或返回链接，以选择

更多待传送文件。

注 :如果您传送的是计算器上已存在的文件，则会创建一个文件副本，并

在文件名中附加一个编号。

4. 计算器屏幕将显示包含以下选项的提示 :
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打开 - 打开已传送文件。

转至 - 打开“我的文档”文件夹并突出显示已传送的文件。

确定 - 清除此提示。

注 :如果您传送多个文件，则提示将仅适用于已传送的最后一个文件。

更新操作系统

更新计算器上的操作系统 :

1. 导航到操作系统更新页面。

应用程序将检查计算器上的操作系统版本。如果有新版本可用，系统将提
示您更新。

2. 单击更新操作系统按钮。

更新完成后，将显示一条确认消息。



一般信息

在线帮助

education.ti.com/eguide

选择您的国家，获取更多产品信息。

联络 TI 支持部门

education.ti.com/ti-cares

选择您的国家，获取技术和其他支持资源。

维修和保修信息

education.ti.com/warranty

选择您所在的国家/地区，了解有关保修期限和条款或产品服务的信息。

保修期内不会影响您的法定权利。

Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243

充电电池的注意事项

• 请不要将电池暴露在超过 60¡C (140¡F) 的高温环境中。

• 请不要拆卸或破坏电池。

• 仅使用推荐的电池充电器，或随原设备附送的充电器。

• TI 建议您使用此计算器随附的 USB 线缆。如果您选择使用第三方电源适
配器连接 TI 提供的 USB 线缆，应使用符合适用的安全和操作标准并获得
认证( 包括 UL 和 CE 认证) 的适配器。

更换充电电池时要注意以下注意事项 :

• 仅能用 TI 认可的电池进行更换。

• 未使用或未充电时，将电池从充电器或交流电适配器中取出。

• 将电池用于其他设备可能导致人员受伤及设备或财产损失。

• 不要混用不同品牌或同一品牌不同类型的电池。如果更换了错误类型的
电池，则存在爆炸风险。

弃置电池

不要切割、穿刺电池或将其丢至火中。电池可能爆裂或爆炸，释放出有毒的
化学物质。请按照当地法规处置电池。
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